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Important Notice

This guide is subject to the following conditions and restrictions:
•

•
•

•
•
•

This User’s Manual provides documentation for the PowerTerm WebConnect HostView
client. Your specific PowerTerm WebConnect product might include only a portion of the
features documented in this Manual.
The proprietary information belonging to Ericom® Software Ltd. is supplied solely for the
purpose of assisting explicitly and properly authorized users of PowerTerm® WebConnect.
No part of its contents may be used for any other purpose, disclosed to any person or firm, or
reproduced by any means, electronic and mechanical, without the express prior written
permission of Ericom® Software Ltd.
The text and graphics are for the purpose of illustration and reference only. The specifications
on which they are based are subject to change without notice.
The software describe in this document is furnished under a license agreement. The software
may be used or copied only in accordance with the terms of that agreement.
Information in this document is subject to change without notice. Corporate and individual
names and data used in examples herein are fictitious unless otherwise noted.

Copyright © 1999 - 2008 Ericom® Software Ltd.
Ericom® and PowerTerm® are registered trademarks of Ericom® Software Ltd., which may be
registered in certain jurisdictions. Other company and brand, product and service names are
trademarks or registered trademarks of their respective holders.
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About this Guide

PowerTerm WebConnect HostView is a fully functional terminal emulator for Microsoft
Windows, Linux, Mac OS X, and Solaris.
This Manual assumes that you are familiar with basic windowing system conventions (file
transferring, copy/paste functions, etc.) and the operation of the terminal you intend to emulate.
The PowerTerm WebConnect HostView User’s Manual is comprised of the following chapters:
Chapter 1, Introduction to PowerTerm WebConnect HostView, presents the HostView client
and describes its main features. It also provides a quick guide to working with HostView.
Chapter 2, The PowerTerm WebConnect HostView Window, provides an overview of the
HostView window and its components.
Chapter 3, Using PowerTerm WebConnect HostView, provides step-by-step instructions for
using HostView.
Chapter 4, Scripts, describes the use of the Power Script Language (PSL). For a more detailed
description of each PSL command, see the “PowerTerm Script Language, Programmer’s
Reference”, available as a Webhelp (html).
Chapter 5, Menu Reference, describes each of the HostView menu options.
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Chapter

1

Introduction to PowerTerm WebConnect
HostView

This chapter presents the HostView client and its main features. A "quick guide" is also provided.
It describes the basic steps for users who are familiar with accessing remote terminals.
This chapter includes the following topics:
•
•
•
•
•

What is HostView?
HostView Features
System Requirements
HostView Setup
A Quick Guide Through HostView
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What is HostView?
HostView is a fully functional emulation for Microsoft Windows, Linux, Mac, and Solaris
operating systems. It emulates various terminal types, including UNIX, OpenVMS and IBM.
HostView enables you to connect to a single host or multiple hosts via both network and remote
connections.
HostView provides two main features to enable the PC to act and feel like a real host terminal:
•

•

Terminal display emulation
HostView emulates the exact display of the chosen terminal. It presents host applications
exactly as they would appear on the terminal. Once the PC connects to a host computer, all
host operations can be performed as if the PC is an actual terminal.
Terminal keyboard emulation
HostView enables you to emulate the selected terminal’s keyboard by mapping the PC keys
to match the host keys. Keyboard mapping definitions are stored in a .ptk file.

HostView also provides various options to customize and optimize the working environment such
as:
•
•
•

Power Pad (Windows edition only)
A programmable floating keypad.
Function buttons
Programmable buttons located at the bottom of the HostView window.
PowerTerm Script Language (PSL)
A special programming language, which enables you to create scripts for automating tasks.
For example, you can create a PSL script for automatic login. Scripts can be used at startup of
HostView, or can be utilized anytime during a HostView session. PSL is intended for users
with scripting or programming skills. PSL commands can also be assigned to the Power Pad
and the Function buttons to enable additional functions with a click of the mouse.

HostView enables you to use the standard Microsoft DDE mechanism to communicate with other
Windows applications as a DDE client or DDE server application.
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HostView Features
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

•
•
•

Compact, light and high performance program.
32-bit support for Windows 95/98/2000/NT/XP/2003, Linux, Mac OS X, and Solaris.
File transfer for Xmodem, Ymodem, Zmodem, Kermit, Ascii, Binary and IND$FILE.
Support for TCP/IP WinSock, DECnet (CTERM) and LAT.
Support for RS-232 (both direct and via modem), PPP/SLIP, SNA and APPC connections.
Support for Ethernet and Token ring networks.
Script recording for automation of tasks with PowerTerm Script Language (PSL).
String functions, including sub-string, index and concatenation.
Enables you to save parameters for all sessions.
High-level API enables access from other environments, such as C++, Visual Basic and
Power Builder. It also supports EHLLAPI.
Support for most Western and Eastern European languages.
Modem dialing.
Multi-session capabilities.
User programmable Function buttons.
Control of color selection and screen attributes.
Support for printing including Auto Print mode and Slave Printing, Advanced Printing
capabilities: including TN5250 host print transform, specifying the orientation of the printed
output for non-graphic printing, setting values for CPI/LPI/FONT parameters, printer rows
and columns.
Support for Kermit get command.
Floating Power Pad with programmable buttons.
DDE communication for client or server.
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System Requirements
To run HostView you need:
•
•
•
•

MS Windows version 95 or higher.
386 data processor or higher.
Connection to a host computer.
9.1 MB free space on your hard disk.
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HostView Setup
To enable PC-host interaction, you need to define two sets of parameters:
•
•

Terminal parameters
Communication parameters

These are both saved in a Terminal setup file where the default is called ptdef.pts.
Setup file extensions are:
•
•
•

pts for the Terminal setup file.
ptc for the Communication setup file.
ptk for the Keyboard definitions file.

HostView provides the option to work with a single host connection or multiple connections. You
can create different setup files for working with each connection to enable each user a customized
working environment.

Working with a Single Terminal Connection
If you only need to connect to a single host connection, you should use the default terminal setup
and communication file. HostView automatically uses the parameters in the setup file to start the
system.

Working with Multiple Terminal Connections
If you are working with multiple terminal connections, you may need to use a different setup file
for each connection. To create a setup file, you first need to define the terminal setup and
communication parameters, and then save these parameters to a terminal setup file. For more
information about setup files, see Chapter 3: “Using PowerTerm WebConnect HostView”.
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Chapter 2:

Chapter

2

The PowerTerm WebConnect HostView
Work Area

This chapter provides an overview of the HostView window and its components. The HostView
window contains menu and toolbar options that provide access to most HostView functions.
Right-clicking the relevant HostView object can access even more HostView functions.
The most important feature of the HostView window is its work area, which emulates a host
terminal screen by displaying data entered on your terminal, and data received from the host.
This chapter also includes a section describing how to select text in HostView.
This chapter describes the following topics:
•
•
•
•
•
•

The HostView Window
Menu Bar
Toolbar
Hot Keys
Manipulating Desktop Components
Selecting Text
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The HostView Window

The HostView window consists of the following components:
Control Menu Box

Provides standard Windows commands and enables you to
redisplay the Menu bar.

Title Bar

Displays the application name. During a communication
session, the ID type and/or the host name is displayed next to
the application name.

Menu Bar

Contains dropdown menus, which enable the user to perform
most HostView operations.

Toolbar

Contains buttons, which can be used as shortcuts to access
frequently used menu commands.

Work Area

Displays the data entered on the PC terminal or received from
the host. During an emulation session, this work area emulates
a terminal display. For IBM terminal types, the work area is
displayed in black.

History Scroll Bar

Enables you to scroll up and down through the HostView
window to view previously displayed data. Displayed by
default.
For non-IBM emulations only.

Emulator Type

Displays the current terminal emulation type selected from the
Emulation tab in the Terminal Setup dialog box.

Cursor Position Counter

Displays the current line and column position of the text cursor
in the work area.

Caps

Indicates whether the keyboard is in Caps lock mode.

Hold

Indicates whether the screen is in hold or frozen mode.

Status Indicator –
On Line,
Off Line, Printer,
Auto Prt

•
•

•

The status indicator reads On Line when communication is
established.
The indicator reads Printer when data is transmitted with a
printing request to the slave printer. The color of the
indicator is the same as when HostView is in On Line
mode. For example, the printer will appear in red if the
system was On Line when the printing request arrived.
The date is sent to the screen and printer, and the indicator
reads Auto Prt, when the terminal is in Automatic
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Printing mode.
Function buttons Area

Contains a series of buttons that you can program to execute
specific script commands.

Macro/Message Display Area

Displays system messages, or a script sequence as you type it in
the work area.

Minimize button

Closes the window, but not HostView.
• Click the HostView button appearing in the Taskbar to
reopen the HostView window.

Maximize button

Enlarges the window so that it fills the entire screen. The button
is then replaced with the Restore button. This button is used to
restore the window to its previous size.

Window Border and Corners

Changes the size of the window. The characters that appear in
the work area are scaled up or down so that all the information
always remains in view.
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Menu Bar
The HostView Menu bar displays the main HostView functions in dropdown menus.
The following is a brief description of each HostView menu and the functions that it can perform.
File Menu

Provides options to create, save and restore a terminal setup file
as well as to set printing parameters, print the screen and open a
new instance of the HostView window.
The File menu also enables you to save your keyboard and
Power Pad settings, and open them at a later date.

Edit Menu

Provides options to select, clear and reverse text in the
HostView window as well as delete the contents of the history
buffer.
The Edit menu also provides standard windowing operating
system commands (copy and paste), in addition to commands
that enable you to copy data to a file or to the Clipboard.

Terminal Menu

Provides options to define and reset connection (terminal and
communication) parameters, set the system to be online or
offline, and freeze or unfreeze the screen.
You can also select the fonts to be displayed in the HostView
window.

Communication Menu

Provides options to define and modify the communication
(session) parameters, and to disconnect a HostView session.
The Communication menu also provides options for file
transfer as well as to select a modem, add customized modem
definitions and edit the initialization string.

Sessions menu

Provides easy access to multiple sessions of HostView. An
alternative to navigating with the Toolbar buttons.

Options Menu

Provides options to display and edit the keyboard mapping, and
define the Power Pad display.
The Options menu also enables you to capture session data in a
log file for debugging purposes and provides options to hide or
show HostView window components.

Script Menu

Provides options to record, edit and run a script as well as open
and save scripts.

Help Menu

Provides options for accessing the HostView online helps and
product information.

Working with Menus and Commands
You can select menus and commands by:
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•
•
•


Using a mouse
Using direction keys
Typing a letter
To select a menu item using the mouse:

1
2

Click the desired menu on the menu bar. The menu drops down.
Click the desired menu item.

N

1
2
3
4


OTE After clicking the name of a menu or the menu bar, you can drag the mouse
to the right, left or up and down to move to other options.

To select a menu item using direction keys:
Press the <Alt> key to access the menu bar. The far left menu is highlighted.
Use the direction (arrow) keys to move the highlighting bar to select a menu.
Press the down arrow to open the menu.
Use the up and down arrows to highlight the command that you want and press <Enter>.
To select a menu or menu item by typing a letter:

Menus, menu items and commands have an underline character.
1
Hold down the <Alt> key and type the underlined letter of the desired menu. For
example, hold down the <Alt> key and type the letter <F> to open the File menu.
2
Type the desired menu item’s underlined character.
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Toolbar
The HostView Toolbar contains buttons, which provide shortcuts to frequently used menu
options.

N

OTE For IBM emulation types, the Toolbar consists of fewer options.

The following is a brief description of each HostView Toolbar button and its function:
Hold Screen/Release Hold

Freezes and unfreezes the HostView window.
The STOP button appears red when the HostView window
freezes and green when it unfreezes.
Equivalent to Terminal | Hold Screen.

Connect/Disconnect

Enables you to define session communication parameters and
connect to the host computer.
Disconnects an open session.
Equivalent to Communication | Connect (Disconnect).

Copy To Clipboard

Copies selected data displayed in the HostView work area to
the Clipboard.
Equivalent to Edit | Copy.

Paste From Clipboard

Pastes data from the Clipboard to the host application.
Equivalent to Edit | Paste.

Print

Prints selected text or the entire contents of the work area.
Equivalent to File | Print Screen.

Start/Stop Auto Print

Starts/Stops printing incoming data as it is displayed on the
screen. Equivalent to File | Start Auto Print (Stop Printing).

Dial

Enables you to dial a specific telephone number for COM type
communication.
Equivalent to Communication | Utilities | Dial.

Start/Stop Script Recording

Starts/Stops recording manual operations that you perform, in
script form.
Equivalent to Script | Start (Stop) Script Recording.

Change to 80 Columns

Specifies an 80-column display for the HostView work area.
Equivalent to Terminal | Setup | Display | Dimensions 80
Columns.
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Change to 132 Columns

Specifies a 132-column display for the HostView work area.
Equivalent to Terminal | Setup | Display | Dimensions 132
Columns.

Terminal Setup

Displays the Terminal Setup dialog box in which you can
define terminal setup parameters.
Equivalent to Terminal | Setup.

Keyboard Mapping

Opens the Keyboard Mapping dialog box in which you can
map PC keys to host keys.
Equivalent to Options | Keyboard Map.

Show/Hide Power Pad

Displays/Closes the Power Pad dialog box.
Equivalent to Options | Show (Hide) Power Pad.

Help Contents

Displays the HostView online help.
Equivalent to Help | Contents.

New Terminal Window

Opens a new instance of the HostView window. This option
enables you to conduct several sessions concurrently.
Equivalent to File | New Terminal Window.

Session

Displays an icon for each additional session of HostView.


•

To display a description of what each button does:
Place your mouse cursor over a tool to display the tool tip.
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Hot Keys
Hot Keys are keyboard keys that you can press instead of selecting menu commands. These Hot
Keys refer to your standard PC keyboard keys, before they are mapped to terminal keys. Once
Hot Keys are mapped, they loose their original function and reflect the newly mapped terminal
key. For example, if you map <Alt F4> to the <Backspace> key on the terminal keyboard, it
performs the function of a <Backspace> key.
The following table lists the default HostView Hot Keys:
Alt F4

Exit

Alt F6

Open new terminal window

Alt F9

Activate script

Ctrl + Alt F9

Start/Stop recording script

Alt F10

Select screen

Alt F11

Clear screen

Alt F12

Reverse screen

Scroll Lock

Hold screen

Pause

Change the cursor shape

Ctrl Up Arrow

Scroll up one line

Ctrl Down Arrow

Scroll down one line

Ctrl Home

Scroll to beginning of the history buffer

Ctrl End

Scroll to end of the history buffer

Ctrl Page Up

Scroll up one page

Ctrl Page Down

Scroll down one page

Shift + Ctrl + X

Switch focus to session X
X is the session letter (A…Z) displayed in the HostView
window Title bar.

Ctrl + Spacebar

Switch to the next active session
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Manipulating Desktop Components
HostView enables you to customize the HostView window by displaying or hiding desktop
components and changing the display colors for different text attributes. The color attributes
change according to the emulation type you have selected.

•
•

•
•

•
•

•
•

•
•


To show/hide the Menu bar:
Select Options | Hide Menu. This removes the menu bar altogether.
Click the Control Menu box, and then select Restore Menu, to restore the Menu bar.
To show/hide the Function buttons:
Select Options | Hide Buttons. The menu option becomes Show Buttons.
Select again to redisplay the Function buttons bar.
To show/hide the Status bar:
Select Options | Hide Status Bar. The menu option becomes Show Status Bar.
Select again to redisplay the Status bar.
To show/hide the Toolbar:
Select Options | Hide Tool Bar. The menu option becomes Show Tool Bar.
Select again to redisplay the Toolbar.
To show/hide the Power Pad:
Select Options | Show Power Pad. The menu option becomes Hide Power Pad.
Select again to hide the Power Pad.
To show/hide the History Scroll bar:

N

OTE This option is only available for non-IBM emulations.

1
2
3
4

Select Terminal | Setup. The Terminal Setup dialog box appears.
Click the Display tab. The Display Property page is displayed.
Select History Scroll Bar in the General section.
Click OK. The HostView window is redisplayed with the history scroll bar displayed.

•

Clear History Scroll Bar to remove the history scroll bar from the HostView window.



To change the display color of the HostView window:

The color for the Normal attribute determines the color of the entire work area. The box above
the Select Attribute parameter shows the result of your selections.
For non-IBM emulations, the Select Attribute of the entire screen is generally Normal.
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1
2
3

4


Select Terminal | Setup. The Terminal Setup dialog box appears.
Click the Colors tab. The Colors Property page is displayed.
Click the attribute for which you want to define foreground and background colors.
• In the Text area, click the color that you want to apply to the text (foreground) of the
display.
• In the Background area, click the color that will apply to the background for the text.
Click OK. The HostView window displays the selected colors.
To disable/enable underline:

You can choose whether to display data with or without the underline, for data received from the
host with the underline attribute.
1
Select Terminal | Setup. The Terminal Setup dialog box appears.
2
Click the Colors tab. The Colors Property page is displayed.
3
Select/Clear Enable Underline as desired.


To disable/enable blink:

You can choose whether to enable blinking of data, for data from the host with the blinking
attribute.
1
Select Terminal | Setup. The Terminal Setup dialog box appears.
2
Click the Colors tab. The Colors Property page is displayed.
3
Select/Clear Enable Blinking as desired.


To disable/enable host colors:

You can choose whether to work with the host colors or with your own (PC) color scheme.
1
Select Terminal | Setup. The Terminal Setup dialog box appears.
2
Click the Colors tab. The Colors Property page is displayed.
3
Select/Clear Disable Host Colors as desired.
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Selecting Text
You can select text in the work area using the mouse. The following are descriptions of specific
text selection techniques that you may find useful in different emulations.

•
•

To select a word:
Click a word to select it.
Press <Ctrl> and click a word to select it and any punctuation marks or other symbols, up to
the first space that follows them.

N


OTE If the Automatic Copy option in the Edit menu is activated (default),
selecting text also copies the selection to the Clipboard.

To select a block:

A block is any section of the work area.
For VT emulations:
1
Point to one corner of the block.
2
Press <Ctrl> and drag the mouse to the opposite corner of the block.
For 3270 and 5250 emulations:
1
Point to one corner of the block.
2
Drag the mouse to the opposite corner of the block.

1
2



To select full lines:
Point anywhere in a line.
Press <Shift> and drag the mouse, down or up, to the last line you want to include in the
selection.
To select a string:

For VT emulations:
1
Point to the first character that you want to include in the selection.
2
Drag the mouse to the last character that you want to include in the selection and release
the mouse button.
For 5250 and 3270 emulations:
1
Point to the first character that you want to include in the selection.
2
Hold down the <Ctrl> key and drag the mouse to the last character that you want to
include in the selection.
3
Release the mouse button.

•

To select the entire screen:
Select Edit | Select Screen. The whole work area is selected.
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To select a menu entry:

For VT emulations only.
•



Double-click a word and press <Enter>. The word is sent to the host followed by an <Enter>
signal. For example, if the emulation screen displays an application menu residing on the
host, click a menu entry to activate the program that the menu entry represents.
To activate light pen support:

N
•

OTE For 3270 emulations only.

Double-clicking on the screen is equivalent to touching it with a light pen.
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Chapter

3

Using PowerTerm WebConnect HostView

This chapter provides step-by-step instructions for using HostView and provides a detailed
explanation of each step. Depending on your granted permissions you may only be able to see
and modify part of the described options.
This chapter consists of the following topics:
Step 1: Starting HostView
Step 2: Setting up your Working Environment
Step 3: Defining Settings for Terminal Emulation
Step 4: Defining Communication Settings
Step 5: Saving the Terminal Setup File
Step 6: Working with the Host
Step 7: Ending a HostView Session
Step 8: Exiting HostView
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Step 1: Starting HostView
Your administrator will provide you with a URL to run the HostView client.

1
2
3

4

To start HostView:
Go to the URL provided by your administrator. A security warning from your Web
browser is displayed.
Click Yes. The HostView client is downloaded and the Login dialog appears.
Enter your username and password and click Login. The Connect list with available
connections appears. If there only is one connection available, it will be selected by
default.
Select a connection and click Connect. The HostView window opens.
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Step 2: Setting Up your Working
Environment
This section provides a description of the basic operations that may be performed to set up and
optimize the HostView working environment for your usage. You can customize the HostView
window to show or hide window components and change the display of the window. These
options are all described in the Manipulating desktop components section of Chapter 2 “The
HostView Window”.
HostView enables you to emulate a host keyboard by assigning (mapping) PC keys to host keys.
It furthermore provides two features, the Power Pad and Function buttons, which enable you to
automate commands as well as to save your keyboard and/or Power Pad settings in separate files
and open them at a later date.

N

OTE Changes made to either feature will not affect the others.

To set up the HostView work environment:
•
•
•
•
•
•

Mapping the PC Keyboard
Saving and Opening Keyboard Mapping Settings
Programming the Power Pad
Saving and Opening your Power Pad Settings
Programming Function buttons
Selecting Fonts

Mapping the PC Keyboard
HostView enables you to map PC keys to host keys in order to emulate the host terminal
keyboard. The keyboard mapping definitions are stored in a file with the same name as the
current terminal setup file, with the extension .ptk. For example, the default keyboard mapping
definitions are stored in a file called ptdef.ptk.

1
2


1
2

To view the default keyboard mapping:
Select Options | Keyboard Map. The Keyboard Mapping dialog box appears.
Slide the mouse pointer over the different keys. The bottom line of the dialog box shows
you the corresponding PC and terminal keys. For example, if you point to the “t” key of
the VT Keyboard, you see that the corresponding PC key is “T”.
To map a PC key to a host key:
Select Options | Keyboard Map. The Keyboard Mapping dialog box appears.
Drag a key from the upper terminal keyboard to a PC key on the lower keyboard.
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•


1
2
3


•
•

•


Click the <Shift> or <Control> keys on the terminal keyboard to display additional key
functions. For example, if you click the <Shift> key, the alphabet keys on the terminal
keyboard are displayed in upper case. You can then map (drag) these keys to your PC
keyboard keys.
To assign a script command to a PC key:
Select Options | Keyboard Map. The Keyboard Mapping dialog box appears.
Right-click a key on the PC keyboard that you want to assign a command and select
Enter Script Commands. The PC Button dialog box appears.
Enter the script command description and click OK. The PC key has now been assigned a
script command.
To map combinations of keys that include Alt, Ctrl and Shift:
Click the <Alt>, <Ctrl> or <Shift> key (or any combination) on your PC keyboard. Then
map keys by following the procedure described previously.
Click the required <Alt>, <Ctrl> or <Shift> key (or any combination), to view the mapped
key.
To cancel a keyboard key definition:
Drag the PC key definition that you want to cancel, in the Keyboard Mapping dialog box, to
the wastebasket icon. This restores the default function of the PC key.
To replace a PC key with another PC key:

HostView enables you to move the functionality of a mapped PC key to another PC key. For
example, you can drag the F6 key on the PC keyboard to the spacebar on the PC keyboard to give
it F6 functionality.
• Drag the desired PC key, in the Keyboard Mapping dialog box, onto the PC key that it will
replace. The functionality of the PC key has been replaced.
• Drag the replacing key back to its original position, to restore the values.


To copy a PC key to another PC key:

HostView enables you to copy the function of one PC key to another PC key.
• Hold the <Ctrl> key, in the Keyboard Mapping dialog box, while you drag the PC key
whose function you want to copy to the required PC key. Both keys now have the same
functionality.

•

To restore the default keyboard mapping of all mapped keys:
Click the Default button, in the Keyboard Mapping dialog box.

Saving and Opening Keyboard Mapping Settings
HostView enables you to save keyboard-mapping settings in separate files and open them at a
later date.

1

To save keyboard mapping settings:
Select File | Save Keyboard File. The Save Keyboard File dialog box appears.
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Select the directory in which you want to save the file.
Enter a file name. The file extension .kbd is automatically added to the file name.
Click Save. The keyboard-mapping file is saved.
To open a predefined keyboard mapping settings:
Select File | Open Keyboard File. The Open Keyboard File dialog box appears.
Select the directory in which the keyboard file is saved.
Select the required file from the files list and click Open. Parameters defined in the
selected keyboard file are now applied to the current session.

Programming the Power Pad
The Power Pad is a floating keypad for which its buttons can be programmed to execute
customized PSL scripts. The buttons are by default named F1, F2, F3, and so on, with a few
default function names, such as Clear, Enter and Insert. The number of displayed buttons and
their names can be changed. You send the programmed command to the host by clicking the
desired Power Pad button. For more information on how to create scripts, see Chapter 4:
“Scripts”.

1
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To program the Power Pad:
Select Options | Show Power Pad. The Power Pad appears.
Right-click the Power Pad button that you want to program. The Power Pad Button
dialog box appears.
Type the Button Description (that is, the name that will appear on the Power Pad
button).
Type the Script Commands to be run by this Power Pad button. For example, “send
<f13>”. You can type several scripts separated by semicolons.
Click OK. The Power Pad button is now displayed with its new name and will execute
the defined script.
To adjust the number of buttons in the Power Pad:

You can display a maximum of 10 rows and 10 columns in the Power Pad, whereas the defaults
are 9 rows and 4 columns.
1
Select Options | Power Pad Setup. The Power Pad Setup dialog box appears.
2
Select the number of rows and/or columns that you desire from the dropdown boxes.
3
Click OK. The Power Pad opens with the number of rows and columns specified.

Saving and Opening Power Pad Settings
HostView enables you to save your Power Pad settings in separate files and open them at a later
date.

1
2
3
4

To save your Power Pad settings:
Select File | Save Power Pad File. The Save Power Pad File dialog box appears.
Select the directory in which you want to save the file.
Enter a file name. The file extension .pad is automatically added to the file name.
Click Save. The settings are saved.
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To open predefined Power Pad settings:
Select File | Open Power Pad File. The Open Power Pad File dialog box appears.
Select the directory in which the Power Pad file is saved.
Select the required file from the files list and click Open. Parameters defined in the
selected Power Pad file are now applied to the current session.

Programming Function buttons
Along the bottom of the HostView window are twelve programmable Function buttons by default
named from F1 to F12. These can be renamed and programmed to execute customized scripts.
You send the programmed command to the host by clicking the desired Soft button.
The Soft button parameters are saved automatically in the terminal setup file.

1
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To program Function buttons:
Right-click the Soft button that you want to program. The Function Button dialog box
appears.
Type the Function Description (that is, the name that will appear on the button).
Type the Script Commands to be run by this button. For example, “exec notepad”. You
can type several scripts separated by semicolons.
Click OK. The Soft button is now displayed with its new name and will execute the
defined script.

Selecting Fonts
HostView enables you to use standard system fonts or select special PowerTerm fonts to be
displayed in the HostView window.
•
•

•

1
2
3

System fonts are standard general-purpose fonts, which different attributes can be set.
PowerTerm fonts are scaleable fonts, automatically calculated according to the screen size
of the host application and whether the Unscaled screen option is selected or not.
To select PowerTerm fonts:
Select Terminal | PowerTerm Fonts. The HostView window will now display PowerTerm
fonts.
To select system fonts:
Select Terminal | System Fonts. The Font dialog box appears.
Select the font, style, and size, as you desire.
Click OK. The HostView window will now display the selected system font.
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Step 3: Defining Settings for a
Terminal Emulation (Terminal
Settings)
HostView enables you to define the terminal settings for connecting to a host. Once you have
defined terminal settings, you can save them as a setup file. This file can be activated at startup or
opened manually during a HostView session.
Each setting option is displayed in the format of a property page in the Terminal Setup dialog
box.

N

OTE You first have to select an emulation type and then define the other
settings.

The terminal settings provided by HostView are:
•
•
•
•
•
•
•
•

Emulation, displays supported terminal emulations and enables you to select a terminal type.
General, defines parameters for the terminal emulation type.
Display, defines display settings for the HostView window.
Keyboard, defines keyboard setup parameters.
Printer, defines printer parameters.
Tabs, defines tab stops in the work area.
Colors, defines color settings for the HostView window.
Preferences, defines parameters that determine HostView behavior and automate processes.

I

MPORTANT The parameters that you define will only remain active for the current
session, unless you save them in a setup file. For more information, see Step 5:
“Saving the Terminal Setup File”.

Emulation Property Page
The Emulation property page displays the emulation terminal types available with this version
of HostView. The emulation type that you select changes the tabs (property pages) displayed in
the Terminal Setup dialog box. Some emulation types also change the look of the HostView
desktop. For example, for 3270 and 5250 terminal types the work area is black and the toolbar
contains fewer buttons.

1
2
3

To define settings for terminal emulation:
Select Terminal | Setup. The Terminal Setup dialog box appears.
Select the Emulation tab. The Emulation property page is displayed.
Select the terminal type that you require from the list of supported emulations.

General Property Page
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The General property page enables you to define parameters for the selected emulation type.


To define emulation parameters:

1
2
3

N

Select Terminal | Setup. The Terminal Setup dialog box appears.
Select the General tab. The General property page is displayed.
Select the parameters that you require.
OTE The selected host application will usually determine the default option.

The parameters displayed in the General property page are:
Terminal ID

Determines the ID returned by the emulation program to the
host. Verify that you select an ID that the host application
recognizes.

NRC Set

Determines the communication and keyboard character set for
7-bit date only. You can either select None or one of the
languages available.

UPS Set

Determines the communication and keyboard character set for
8-bit data only. Select one of the available character sets.

8 bit Controls

Enabled when UPS Set is specified as Code Page 437 and up.
• Disable determines if 0x80 to 0xAF are displayed
characters.
• Enable determines if 0x80 to 0xAD are control characters.
• 0x9B all characters are displayed characters except 0x9B,
which is a control character.

Online

Equivalent to Terminal | On Line (Off Line).

New Line

Determines whether the <Enter> key generates only a carriage
return or a carriage return/line feed combination.

Use 8 Bit Data Characters

•
•
•

User Defined Keys (UDK)

•

•
•

Select this parameter if the communicated data is in 8-bit
character format.
Clear it for 7-bit characters. When cleared, the 8th bit is
truncated.
If you receive 7-bit data, you can convert it to 8-bit data for
printing on the slave printer.
Locked Determines whether applications on the host
system can override your user-defined keys when you have
defined a function key that conflicts from being overridden.
Unlocked allows them to be overridden.
UDKs let you use a single key for multiple keystrokes. To
program the 15 UDKs, 256 bytes are available. The key
definitions are loaded sequentially (from F6 to F20), so that
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if you reach the 256-byte limit, more definitions cannot be
loaded.
Cursor Keys

Determines whether the four arrow keys generate ANSIstandard control sequences for moving the cursor, or generate
customized application program functions.

Keypad

Determines the effects of the numeric keypad on your
keyboard.
• Numeric Keypad keys insert numbers. For example,
pressing <7> on the numeric keypad is the same as typing
<7> on the keyboard.
• Application Keypad keys generate control sequences that
can be used by some applications.

Cursor coupling

Select this parameter to cause the cursor to remain visible
during page scrolling.

Status Line

•
•
•

None Displays an emulation screen without the status line.
Indicator Displays the status line.
Host Writeable Displays the status line sent by the host.

Unique parameters for the 3270 and 5250 emulation types:
General

•

•
•

ID Determines the ID returned by the emulation program to
the host. Make sure you select an ID that the host
application recognizes.
Unscaled Screen Select this parameter if you want to
disable the scaleable feature for HostView fonts.
Show Response Time Select this parameter if you want to
display the number of seconds that elapsed between the
time data was sent to the host and the host response time.

Cursor Ruler

Displays full-screen, vertical or horizontal lines as a cursor
ruler.

Cursor

Controls the cursor display.

Appearance

•
•

Power GUI Displays data in a window with 3D look and
feel.
Show Frame Places a frame around the text area of the
emulation.

HLLAPI Names

Specify HLLAPI names here.

Code Page

Specifies the keyboard mode. This sends the correct keystrokes
for a specific country or language’s keyboard layout to the host.

Alternate Size

•

Enable Select to override the terminal alternate size with a
specific size.
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•

Rows/Columns Type the required number.

Display Property Page
The Display property page enables you to define parameters that determine the appearance
(display) of the HostView window.

N

OTE For non-IBM emulations only.



To define display parameters:

1
2
3

Select Terminal | Setup. The Terminal Setup dialog box appears.
Select the Display tab. The Display property page is displayed.
Select the parameters that you require.

The parameters displayed in the Display property page are:
General

•
•
•
•

Reverse Display Colors Reverses the text and background
colors in the work area.
Unscaled Screen Select this parameter if you want to
disable the scaleable feature for PowerTerm fonts.
Autowrap Characters Wraps words at the end of a line
and the cursor moves to the next line.
History Scroll Bar Displays the vertical history scroll bar
along the right edge of the HostView screen. This enables
you to scroll through the data displayed previously on the
screen. If the host transmits during scrolling, the display
automatically scrolls back to its current position. Only with
scaled screen.

Cursor Ruler

Displays full-screen, vertical or horizontal lines as a cursor
ruler.

Cursor

Controls the cursor display. Experiment with each parameter to
view the options available.

Ctrl Characters

•
•

Interpret Displays normal text as affected by control
characters.
Display Actually displays the control characters.

Power GUI

Displays data in a window with 3D look and feel.

Show Frame

Places a frame around the text area of the emulation.
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Dimensions

Determines the number of characters (columns) per displayed
line, and the number of lines to be displayed in the work area.
Characters are scaled according to the selected values.
Type a different value in the Other box instead of choosing one
of the standard options (80 and 132).

Scrolling

Determines the pace at which data is displayed in the work area
as it arrives. If you select Jump, you should determine the
Jump Scroll Speed that is measured in number of line units.
The higher the value, the faster the scrolling.
• Unlimited Displays data without delaying communication.
• Page Scrolls data by full screens.
• Smooth is equivalent to a Jump Scroll Speed of 1.

Enable Soft Fonts

Enables you to work with VT soft fonts. The fonts will be
loaded from the host application.

Keyboard Property Page
The Keyboard property page enables you to define keyboard parameters for your PC.

1
2
3

To define keyboard parameters:
Select Terminal | Setup. The Terminal Setup dialog box appears.
Select the Keyboard tab. The Keyboard property page is displayed.
Select the parameters that you require.

The parameters displayed in the Keyboard property page are:
Backspace Key Sends

Determines whether the <Backspace> key sends Delete or an
actual Backspace.

Auto Repeat

Repeatedly displays the character whose key is being
continuously pressed down.

Key Click

Issues a click sound when you press a key on the keyboard.

Local Echo

Determines whether keyboard input is displayed (echoed) on
your screen.
• Select to display the keyboard input even if the host system
does not echo your input.
• Clear to send the keyboard input to the host system without
being displayed on the screen (unless the host system
echoes the characters).

Use Emulator Alt Keys

Select to make an <Alt> key perform the terminal operation
even if Windows OS have an operation on the same key.

Margin bell

Determines whether the terminal sounds a bell tone when the
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cursor reaches the right margin.
Warning Bell

Determines whether the terminal sounds a bell tone when
receiving the “bell” (ASCII 7) character. For operating errors,
mail messages etc.

Use VT Keyboard Mode

Transforms your keyboard to Digital VT keyboard mode. In
this mode, the PC keyboard operates as close to a VT keyboard
as possible, and takes full advantage of LK450 Digital
keyboards.

Use Shift Lock

Select to simulate Shift Lock mode. For example, if you type
“a”, the keyboard issues “A”.

Answerback Message

Specifies an answerback message and its display.
• Clear Deletes the message.
• Conceal Hides the message without being deleted. Click
Clear to cancel the conceal command.

Auto Answerback

Determines whether the terminal automatically sends the
message to the host system after you make the connection. This
is useful if your answerback message is a command to the host
system.

Unique parameters for the 3270 and 5250 emulation types:
Backspace

Select to delete characters by pressing the Backspace key.

Auto Repeat

Repeatedly displays the character for which its key is being
continuously pressed down.

Key Click

Issues a click sound when you press a key on the keyboard.

Typeahead

Types data ahead before the host responds.

Use Emulator ALT Keys

Select to make an <Alt> key perform the terminal operation
even if Windows OS have an operation on the same key

Use Shift Lock

Select to simulate Shift Lock mode. For example, if you type
“a”, the keyboard issues “A”.

Numpad Decimal Sends
Comma

Determines whether the Numeric Pad sends a comma instead
of a decimal.

Lock Numeric Field

Determines whether the keyboard is locked when you try to
enter non-numeric data to numeric only fields.

Non SNA System Wait

Determines whether the System Wait in the IBM 3270
emulation will act as a System Wait in a non-SNA terminal.
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Printer Property Page
The Printer property page enables you to define printer parameters for your PC.
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To define printer parameters:
Select Terminal | Setup. The Terminal Setup dialog box appears.
Select the Printer tab. The Printer property page appears.
Select the parameters that you require.

The parameters displayed in the Printer property page are:
Print Device

Allows you to select a printing output channel.
• None No destination was assigned. The Device File Name
is disabled. Printer data is received by the terminal, but
discarded (not printed).
• Print Manager Sends printing to the standard Windows
Print Manager, in text mode.
• Device Sends printing to the device you designate in the
Device Name text box. This can be a device such as PRN,
lLPT1, COM1, etc. In the Device Name text box, you can
also specify communication parameters. For example:
COM 1:9600,8.
• File Sends printing to the file you type in the File Name
text box.

Device File Name

•
•
•

File Creation Enables you to choose whether to add new
data to an already existing file or to create a new one.
Append Adds data to an existing file.
Overwrite Creates a new file.

Use Form Feed

Adds a form feed (page eject) after each printing job, if you are
printing to a file.

Print Line Graphics As Text

Converts line graphics to text. This speeds up printing on a
slow dot-matrix printer.

CR->CRLF

Adds a line feed after each single carriage return (one that has
no line feed following it) when in slave printing mode.

Print Screen Data
Conversion

Converts data to IBM or Digital character sets.
• None Does not convert data.
• Graphics Prints in Graphics mode. Will always send a
print screen via the Print Manager regardless of the print
device.

Slave Printer Data
Conversion

Converts data to IBM or Digital character sets for slave
printing.
• None Does not convert data.
• Graphics Prints to a postscript printer.
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Slave Printer Job Delimiter

Specifies the job delimiter character that will divide the data
into print jobs, thus disabling the escape sequences arriving
from the host application.

Delay for Print Closing
(Seconds)

The command to close the printer queue is delayed by the
number of seconds that you determine. This command only
takes effect if no open command is issued in the meantime.
Important for printing to cut sheet printers (for example,
inkjets/lasers) and network printers.

Advanced Printing
The Advanced Printer Setup dialog box enables you to define printer parameters.

Non 5250 printing
There are two different modes with different fields enabled:
• Text mode is designated in the Printer property page by setting the two data conversion
combo boxes (Print Screen and Slave Printer) to None.
• Graphics mode is graphic printing.


To set values for non-host print transform in non-graphic mode:

1
2
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4

5

Select the Printer property page.
Click the Advanced Printing button. The Advanced Printer Setup dialog box appears.
Select your printer model, or a compatible one, from the Printer/Type Model drop down
list.
Use the initial printer values that appear in the Font, CPI, LPI, Printer Columns and
Printer Rows combo boxes or override them by clearing the Ignore check box and
selecting the desired value from the adjacent combo box.
Click OK.

The parameters displayed in Text mode are:
Printer Type/Model

Specifies the destination printer.

Ignore

Disables the adjacent combo box. When selected, default values
are applied.

Font

Printer default font and size will be applied to the output when
Ignore is selected. Otherwise, User input will be applied.
Select the desired font from the Font dropdown list.

LPI

Lines Per Inch

CPI

Characters Per Inch
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Printer Columns

Determines the number of printer columns in the output.
Select Ignore to apply the number of columns on your
emulation screen to the output. For graphic printing.

Printer Rows

Determines the number of printer rows in the output.
Select Ignore to apply the default values of the specific
emulation to the output. For graphic printing.

Orientation

For Non Graphic printing.
Specifies the orientation of the printed output. The default
depends on your printer’s settings.

Graphics mode parameters:
•
•

Printer Columns and Printer Rows are the only relevant fields.
Select the desired Orientation in the Print Setup dialog box.

TN5250 Printing Session


To set values for non-host print transform in non-graphic mode:

1
2

Select the Printer property page.
Click the Advance Printing button. The Advanced Printer Setup dialog box is
displayed.
Select your printer model, or a compatible one, from the Printer/Type Model drop down
list.
Use the host values for the Font, CPI, LPI, Printer Columns and Printer Rows or
override them by clearing the Use Host Value check box and selecting the desired value
from the adjacent combo box.
Click OK.

3
4

5



To enable host print transform:

N
1
2
3
4
5
6

OTE For IBM printer only.

Select Enable Host Print Transform.
Select the manufacturer printer type and model from the Printer Type/Model dropdown
list.
Select the paper size from the Drawer 1 dropdown list.
Select the paper size from the Drawer 2 dropdown list.
Select the paper size from the Envelope Hopper dropdown list.
Specify whether the printer has Code Page 899 installed in the Supports ASCII CodePage 899 check box.

Additional steps for Other Printers:
• Specify the Customizing Object.
• Specify the Customizing Object’s Library.
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The parameters displayed are:
Enable Host Printer
Transform

Enables the host to send the printer specific format commands
to the emulation. When disabled, the host sends general format
commands in which the emulation in turn, translates to printer
specific commands.

Printer Type/Model

Specifies the destination printer.

Drawer 1

Specifies the size for the paper in Paper Source 1.

Drawer 2

Specifies the size for the paper in Paper Source 2.

Envelope Hopper

Specifies the size of the envelope.

Supports ASCII Code-Page
899

Specifies whether the printer has Code Page 899 installed.

Customizing Object

Specifies the object name that you have previously defined on
the AS/400.
Enabled only for Other Printer model.

Library

Specifies the customizing object’s library on the AS/400.
Enabled only for Other Printer model.

Tabs Property Page

N

OTE For VT emulations only.

The Tabs property page enables you to determine tabs in the work area. Tabbed data received
from the host will be laid out in the work area according to ruler settings defined with this option.

1
2
3

To define tab parameters:
Select Terminal | Setup. The Terminal Setup dialog box appears.
Select the Tabs tab. The Tabs property page is displayed.
Select the parameters that you require.

The parameters displayed in the Tab property page are:
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Tab Stops

Click anywhere within the Tab Stops area to set tab stops
manually.
• Set Every Sets a tab stop in increments of a number typed
in the adjacent text field.
• Clear All Clears all tab stops.

Colors Property Page
The Colors property page enables you to define the color of data displayed in the work area.
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To define color parameters:
Select Terminal | Setup. The Terminal Setup dialog box appears.
Select the Colors tab. The Colors property page is displayed.
Select the parameters that you require.

The parameters displayed in the Colors property page are:
Preview Box

Shows the result of your selections.

Enable Underline

Enables underlined characters.
Clear to disable displaying data with the underline, for data
transmitted from the host with the Underline attribute.

Enable Blink

Enables blinking.
Clear to disable blinking data, for data transmitted from the host
with the Blink attribute.

Disable Host Colors

Select to ignore specific color assignment by the host. Uses
colors you select for the attributes only.

Show BMP

Specifies a Bitmap Screen as the background for the emulation
window. The desired bitmap should be named pt_bg.bmp and
should be copied to the HostView folder.

Select Attribute

Select the attribute for which you want to define foreground
and background colors. Attributes change according to the
emulation type you selected in the Emulation property page.
Generally, the attribute of the entire screen is Normal. The
color for the Normal attribute determines the color of the entire
work area.

Text

Select the color that will apply to the text (foreground) of the
display.

Background

Select the color that will apply to the background of the text.

Preferences Property Page
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The Preferences property page enables you to determine HostView behavior and automate
processes. They remain active until you change them. For example, if you select to connect
automatically at HostView startup, you will always be connected when you open HostView, until
you change this setting in the Preferences property page.
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To define HostView preferences:
Select Terminal | Setup. The Terminal Setup dialog box appears.
Select the Preferences tab. The Preferences property page is displayed.
Select the parameters that you require.

The parameters displayed in the Preferences property page are:
On Terminal Setup File
Open

•
•

•

Auto Connect Connection is established immediately with
the parameters saved in the default setup file.
Show Connect Dialog box Connection is not established
immediately. The Connect dialog box opens, enabling you
to select the connection parameters that you require.
Do not Connect The HostView window opens. You decide
what to do.

Window Title

Enables you to give the currently active window a name of your
choice.

History Buffer

Specifies the size of the buffer in which data is stored, by
selecting an option from the dropdown list.

On HostView Exit

•
•

•

•

•
On Session Exit

•
•

Save Terminal Setup The new terminal parameters (if you
changed them) are saved to the current terminal setup file.
Confirm Save Terminal parameters are not saved
automatically. HostView displays a dialog box where you
can decide whether or not to save.
Save Window Size & Position Saves the size and position
of the emulation window. Next time you open HostView,
the window appears with the same size and position as last
time.
Confirm Disconnect Session If you close HostView
during a session, you will be requested to confirm
disconnect.
Inactivity Timeout Specifies the time limit for keyboard
inactivity, after which time HostView shuts down.
Auto Reconnect Re-establishes communication if the line
was dropped.
Auto Exit HostView Closes HostView altogether on
disconnect.
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Step 4: Defining Communication
Settings
Communication settings enable you to define the session type, session parameters and select the
script file and setup file. Communication and terminal settings are both saved in a setup file. This
file can be used on HostView startup or opened during a HostView session. For more
information, see Step 1: “Starting HostView” and Step 5: “Saving the Terminal Setup File”. All
sessions in the Sessions List are saved in the ptcomm.ini file.


To define communication settings:

1
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Select Communication | Connect. The Connect dialog box appears.
Select a Terminal Type from the dropdown list.
Click a Session Type. Available types differ according to the selected Terminal type. For
each Session type, HostView displays a set of parameters.
Enter required parameters or select a predefined Setup file. A predefined Script file can
also be selected.
Click Connect. Host connection is established. For more information, see Step 6:
“Connecting to a Host”.

Terminal Type

Changes the current emulation.

Terminal ID

Changes the ID returned by the emulation program to the host.

Device Name

For 5250 Display.
Each new session can automatically be given a new name,
followed by the session number (when using multiple sessions).
For example, if the device name is Test, then the first session
would be Test 1, and the next Test 2, and so on.

Dial Number

For COM Session type.
Specifies the number to be dialed by the modem before
communication is established.

Script File

Specifies the name of a script to be run before communication
is established.

Setup File

Specifies the name of a setting to be opened before
communication is established.

Connect

Connects to the host according to the displayed session
parameters.

Save As

Saves the current session settings.

Modify

Updates a selected session setting, with the data entered in the
upper section of the dialog box.
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Delete

Deletes a session setting.

Session Types
TELNET

Uses the Telnet protocol over TCP/IP for network
communication.
• You must specify the host computer name or the IP address
in the Parameter’s Host Name field.
• You can also specify the Telnet Port Number (default is
23).
• The winsock.dll file must be on the search path.

COM

Uses serial communication with the PC’s COM ports.
• You must specify the Baud Rate, Port Number, Parity,
Stop Bits and Flow Control fields.
• Optionally, you can specify a Dial Number (telephone).

BAPI

For TCP/IP connections with parameters similar to those of
TELNET.
• Verify that the BAPI support software is installed on your
PC before you use this option.

CTERM

•

LAT

Uses DIGITAL LAT protocol for network communication with
a VAX/OpenVMS host via DIGITAL PATHWORKS 32.
• You must specify Service Name and a Password (if
required).

TN3270

TELNET for 3270.
• Select Use TN3270E Protocol if you want to work with
TELNET SNA extensions.
• You can also specify the LU name of the host (LU name or
LU pool).

MS SNA Server

For connection via Microsoft SNA Server.
• Specify the LU Name (or LU pool).

NWSAA (IPX)

For connection via IPX to Novel Netware for SAA. The
Service Name is the same as Novel’s Profile.
• You must select an LU Category.
• You can specify an asterisk, as the Server Name and
HostView will connect to the appropriate Netware for SAA
server.

Uses the DIGITAL CTERM protocol for network
communication with a remote or local VAX/Open VMS
host via DIGITAL PATHWORKS 32. You must specify
the host computer name in the parameter’s Node Name
field.
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NWSAA (TCP/IP)

Same as previous for TCP/IP connection.
• You must specify the server’s IP address or host name in
the Server Name field.

TN5250

TELNET for 5250.

APPC

•
•

Specify the appropriate AS/400 names in Host Name and
Device Name.
Select Auto SignOn if you want to skip the sign on stage.

RLOGIN

Uses the RLOGIN protocol over TCP/IP for network
communication.
• You must specify the host computer name or the IP address
in the Host Name field.
• You can also specify the port number in the Host Name
field.

SUPERLAT

This is a version of the LAT protocol for network
communication with a VAX/OpenVMS host, which requires
Meridian’s SUPERLAT.
• You must specify Service Name and Password (if
required).


•


To enter a Device Name:
Type “<desired device name>+” in the Device Name field.
To specify a Dial Number:

• Type the desired number in the text box.
or,
1
Click the browse button. The Quick Dial Setup dialog box appears with the modem list
of available dial numbers.
2
Select the desired name from the Dial List.
3
Click OK.
 To add a Quick Dial Number:
1
2
3


Type the Name you want to appear in the Dial List.
Enter the Dial Number.
Click OK.
To specify a Script file:

• Type the desired file name in the text box.
or,
1
Click the browse button. The Browse Login Script dialog box appears.
2
Select a file and click Open.


To specify a setup file:
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• Type the desired file name in the text box.
or,
1
Click the browse button. The Browse Terminal Setup dialog box appears.
2
Select a file and click Open.

•

To select a predefined session:
Select a session by clicking its name in the Sessions List. Its parameters appear in the dialog
box.

 To save a session:
1
2
3

1
2
3

1
2
3

Define session parameters.
Click the Save As button. The Save Session dialog box appears. HostView offers a
default session name. You can overwrite this name and specify your own session name.
Click OK. The session is displayed in the Sessions List.
To modify a session:
Select the session you want to modify from the Sessions List.
Enter the new parameters in the upper section of the Connect dialog box.
Click Modify. The new parameters are updated.
To delete a session:
Select the session to delete from the Sessions List.
Click Delete. A confirmation message is displayed.
Click OK to delete the session setting.
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Step 5: Saving the Terminal Setup File
Defined terminal and communication settings can be saved in a setup file. The default Terminal
Setup file extension is .pts. This file can be used to start HostView, to connect to a host using the
predefined terminal and communication parameters, or opened manually during a HostView
session. Changes in settings can be saved to the currently loaded setup file, or under a different
file name if you do not want to overwrite the parameters in the current setup file. Creating an icon
for your current HostView settings, which can be accessed from the Windows Start menu or by
double-clicking on your desktop icon, is also possible as well as saving the settings when you exit
HostView. For more details about saving a setup file when exiting HostView, see Step 9:
“Exiting HostView”.


To create a shortcut for session settings:

1
2
3
4

Locate the HostView shortcut (either on your desktop or in the Start Menu folder).
Right-click Properties. The HostView Properties dialog box appears.
In the Target area, position your cursor after the quotation mark (“).
Type a space and then the name of the required setup file. In the event that the setup file
is in a directory other than that of HostView, type the entire path of the setup file.

N

OTE HostView recognizes Windows file naming conventions, including
spaces in a file name. If you have a setup file with a space in the
name, for example Setup 1.pts, HostView ignores the space and looks
directly for the .pts extension.

5


•

Click OK. Next time the HostView window will be displayed using the parameters
defined in the specified setup file.
To save terminal settings to the current setup file:
Select File | Save Terminal Setup. The current terminal settings are saved.

N

1
2
3
4

1
2
3

OTE This option overwrites parameters previously defined in the setup file.

To save a terminal setup file under a different name:
Select File | Save Terminal Setup As. The Save File As dialog box appears.
Select the directory in the Save in dropdown box in which you want to save the file.
Type the desired file name in the File name text box.
Click Save. The file is saved.
To save HostView settings as an icon:
Select File | Save As Icon. The Save As Icon dialog box appears.
Type the Icon Information that you want to use for your icon.
Click OK.
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N

1
2
3
4

OTE The name of the setup file should be changed to avoid changing the
default settings.

To open a setup file:
Select File | Open Terminal Setup. The Open File dialog box appears.
Select the directory in the Look in dropdown list in which the setup file is located.
Select the required setup file from the files list.
Click Open. Parameters defined in the selected setup file are now available.
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Step 6: Working with the Host
Once you have connected to a host, HostView enables you to perform the following functions:
•
•
•

Transfer files to and from the host
Print data from your host application
Start a new HostView session

Transferring Files
HostView enables you to transfer files between the PC and the host. HostView operates with both
ASCII and non-ASCII files. Before transferring files, you need to define the PC and host data
types. These are defined in the File Transfer Setup dialog box.

N

1
2
3
4

1
2
3
4
5
6

7
8


1
2
3
4
5

OTE File transfer for 5250 emulations is not supported.

To define host and PC data types for file transfer:
Select Communication | File Transfer Setup. The File Transfer Setup dialog box
appears.
Select Convert Data.
Select data types for the host and PC data from each one’s respective dropdown list.
Click OK.
To receive a non-ASCII file from the host:
Connect to a host.
Type in the work area, the command that the host uses to send a file and press <Enter>.
Select Communication | Receive File. The Receive File dialog box appears.
Click any tab, except the ASCII tab.
Click the browse button to specify a directory, if required.
Type a file name in the File Name field.
or,
Leave “.” (or empty) if you want to receive the data into a file that carries the same name
as the name used by the host.
For Kermit functioning in Server mode, select the Use Get check box and specify both
file names in the File Name and Host File Name text boxes.
Click OK. The PC starts to receive the file, which will be saved on the PC disk under the
specified name and directory.
To receive an ASCII file from the host:
Connect to a host.
Type in the work area, the command that displays the file (for example: for UNIX,
cat<filename>; for VAX, type<filename>). Do not press <Enter>.
Select Communication | Receive File. The Receive File dialog box appears.
Click the ASCII tab.
Type in the File Name field, the PC file name that will store the received data.
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6
7
•

Click OK.
Press Enter to activate the command.

At the end of the capture process, select Communication | Stop Receiving ASCII File.


To send a non-ASCII file from the PC to the host:

1
2
3
4
5
6
7


Connect to a host.
Type in the work area, the host’s file reception command and press <Enter>.
Select Communication | Send File. The Send File dialog box appears.
Click any tab, except the ASCII tab.
Click the browse button to specify a directory, if required.
Type a file name in the File Name field.
Click OK.
To send an ASCII file from the PC to the host:

1

Activate the command that will accept the data on the host (for example: for UNIX,
cat<filename> or enter an editor and move to the data entry state within the editor).
Select Communication | Send File. The Send File dialog box appears.
Click the ASCII tab.
Type in the File Name field, the PC file name.
Click OK.

2
3
4
5

Transferring Files for 3270 Emulations
HostView provides IND$FILE transfer for 3270 emulation.

N
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4
5
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OTE All of the command’s parameters can also be modified in the ptdef.pts file
under the [3270 IND$FILE] heading.

To receive files from the host computer:
Select Communication | Receive File. The IND$FILE: Receive File dialog box
appears.
Select the appropriate tab (CMS, TSO or CICS), which reflects your mainframeworking environment.
Specify the PC File Name and Host File Name.
Modify the other parameters as required.
Click OK. A File Transfer Status dialog box with file transfer details appears.
To send files to the host computer:
Select Communication | Send File. The IND$FILE: Send File dialog box appears.
Select the appropriate tab (CMS, TSO or CICS), which reflects your mainframe working
environment.
Specify the PC File Name and Host File Name.
Modify the other parameters as required.
Click OK. A File Transfer Status dialog box with file transfer details appears.
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The parameters displayed are:
PC File Name

The name of the file that resides on the PC.

Host File Name

The name of the file that resides on the mainframe.

File Conversion

•
•

•

File Creation

•
•

Record Format

•
•
•
•

ASCII Specifies converting the file to ASCII format.
CR/LF Specifies deleting a carriage return and a linefeed
character from the end of each line of the file you are
sending, or adding them to the end of each line of the file
you are receiving from the host. CR/LF processing is
typically appropriate for ASCII files.
Local Conversion Specifies converting the file according
to the format specifications that appear in the above Host
and PC fields.
Append Specifies appending the transferred file onto an
existing file with the same name.
Overwrite Specifies that the transferred file overwrites an
existing file with the same name.
Default Specifies the default format for the file residing on
the mainframe.
Fixed Specifies the fixed format for the file residing on the
mainframe.
Variable Specifies the variable format for the file residing
on the mainframe.
Undefined Specifies an undefined format for the file
residing on the mainframe.

Allocation Units

The unit in which to measure the primary and secondary Space
allocation of disk space.
• Tracks Specifies Tracks as the allocation unit.
• Cylinders Specifies Cylinders as the allocation unit.
• AvBlocks Specifies the size (in blocks) for an average
block. Relevant only where you are using blocks as your
allocation unit.

LRECL (Logical Record
Length)

Specifies the record size (in bytes) for the file being created on
the host. For ASCII files, set this value to accommodate the
longest line in your file.
• Range: 0 - 32768.
• Default: Lines of up to 80 characters.

Block Size

Specifies the block size (in bytes) for the file being created on
the host. For files with fixed-length records, this value must be
a multiple of the LRECL.

Space

Specifies the size (in allocation units) of the primary (left box)
and secondary (right box) allocation for the host file being
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created. In the event that the primary allocation is insufficient,
then a secondary allocation is used.
Additional Options

Specifies any parameters specific to the IND$FILE program on
your host system. The contents of this text box are attached to
the end of the transfer command.

Host program

Specifies the name of the host program to be utilized by
HostView to initiate a file transfer.
• Default (only valid option): IND$FILE

Printing Data
HostView enables you to define print parameters and print the terminal screen or data transferred
from the host application.

•

•
•

•

•

1

2


1
2
3
4
5
6

To select a printer and set printing parameters:
Select File | Print Setup. The Print Setup dialog box appears with a set of printing
parameters. The displayed parameters change according to the printer you select. For details,
consult your printer documentation.
The Default printer parameter enables you to send the output to the default printer selected
under Windows.
The Specific printer parameter allows you to select one of the currently installed printers.
To execute a form feed on the printer:
Select File | Form Feed.
To execute a line feed on the printer:
Select File | Line Feed.
To print accumulated data displayed in the work area:
Select File | Start Auto Print. The Start Auto Print command starts accumulating
incoming data while it is displayed on the screen, and the menu option changes to Stop
Printing.
Select File | Stop Printing. The Stop Printing command prints all the data accumulated
in the printing buffer of the slave printer, or in the auto print buffer. If data was buffered
with a printing request and communication failed before the data was sent to the slave
printer, select this command to print the accumulated information.
To print a session using device naming:
Open a session.
Select Terminal | Setup. The Terminal Setup dialog box appears.
Select 5250 Printer from the Emulation tab.
Select the Printer tab and select File from the Print Device dropdown list.
Type Lpt1 in the File Name field and click OK.
Select Communication | Connect. The Connect dialog box appears.
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1
2

Type the name of the AS/400 host in the Host Name field.
Type the name of the device for the printer session in the Device Name field.
Click Connect. The Printer Session dialog box appears. Leave it open. The AS/400
automatically creates a queue with the specified device name.
Open another session, this one a 5250-display session, and send your print jobs to the
queue created by the AS/400.
To print the Terminal Screen:
Mark desired text or the entire contents of the work area.
Select File | Print Screen.

Starting a New HostView Session
HostView enables you to run two or more sessions concurrently by opening a new instance of the
HostView window. Each session is identified by a letter (starting at A), which appears in the
session window title bar. A session is assigned the first available letter. For example, if A, B and
D are opened, the next session opened is assigned C.

•

•

•

To open a new instance of the HostView window:
Select File | New Terminal Window. A new instance of the HostView window opens.
To toggle between open sessions:
Press <Ctrl>+<Spacebar>.
To switch to a specific session:
Press <Shift>+<Ctrl>+<X>, where X is the session letter. For example, if you want to work
in session C, you would press <Shift>+<Ctrl>+<C>.
or
Click the desired session’s icon.
or
Select Sessions | desired session.
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Step 7: Ending a HostView Session
You need to end the session(s) before exiting the HostView application. HostView provides four
options to end a session:
•

•
•
•

Automatic Closing HostView enables you to close HostView automatically when you close
a session. If you have modified terminal parameters during a session, a message displays
asking if you want to save the setup file before closing.
Optional Closing.
User-Initiated Closing Manually closing a session at any time.
User-Initiated Fast Exit Sometimes you require a fast exit while communication is in
progress. HostView then reacts according to the parameters selected in the Preferences tab in
the Terminal Setup dialog box. For more details on how to exit HostView, see Step 9:
“Exiting HostView”.



To define parameters for closing a HostView session
automatically:

1
2
3
4

Select Terminal | Setup. The Terminal Setup dialog box appears.
Select the Preferences tab.
Select Auto Exit HostView in On Session Exit.
Click OK.



To automatically reconnect a HostView session after exiting the
current session:

1
2
3
4

•

•

Select Terminal | Setup. The Terminal Setup dialog box appears.
Select the Preferences tab.
Select Auto Reconnect in On Session Exit.
Click OK.
To manually close a session:
Select Communication | Disconnect.
To fast exit the current session:
Press <Alt>+<F4>.

Optional Closing

N

OTE For non-IBM emulations only.

HostView displays the following message at session termination when Auto Exit PowerTerm, in
the Terminal Setup dialog box is cleared:
Session closed (<exit code>). Hit Enter to restart session.
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<exit code> may have one of the following values:
• Zero (0) Communication ended successfully.
• Any number (other than 0) Communication aborted. The exit code points to the error that
caused the problem.

•

To re-establish communication:
Press Enter to re-establish communication based on the current terminal and communication
parameters.
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Step 8: Exiting HostView

1

2

To exit HostView:
Select File | Exit. If you have changed the terminal settings, HostView displays a
warning message asking if you want to update the terminal settings file. The message will
point to the name of the setup file currently loaded.
Click OK to update the file, or NO to cancel the latest changes and restore the default
setup file.
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Chapter

Scripts

4

The PowerTerm Script Language (PSL) enables you to create scripts for automating tasks. PSL
is intended for users with programming or scripting skills.
For a full description of the different PSL commands, see the “PowerTerm Script Language,
Programmer’s Reference”, available in html format.
This chapter describes the following topics:
•
•

Script Overview
Using PSL Scripts

57

Script Overview
HostView enables you to use scripts to automate tasks. For example, you can create a script to
login to HostView, execute a file, display a message, etc. Scripts can be run upon startup or
during a HostView session. They can be written in any standard text editor, like Notepad and are
saved with a .PSL extension.

PSL Types
The PSL commands can be grouped into different categories:
Simulation transmission to
host commands

Enables you to communicate with the host. For examples, the
<send> command sends data to the host.

Standard programming
commands

Enables you to use standard programming commands. For
example, the <exec> command opens a program.

File handling commands

Enables you to work with files. For example, the <read>
command reads from a file.

HostView-specific commands

Enables you to activate specific HostView features. For
example, the <map> command enables you to map a PC key to
a host key.

Desktop interface commands

Enables you to manipulate components in the HostView
window. For example, the <menu hide> command hides the
HostView menu.

DDE commands

Enables you to use standard Microsoft Windows DDE
mechanisms to communicate with other Windows applications.
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Using HostView Scripts
HostView provides you with the following script options:
•
•
•

•
•
•

1
2
3

4
5
6
7
8

1
2
3
4
5

1
2
3

4
5

Create a Script creates a script to run upon startup or at any time during a HostView session.
Edit a Script edits an existing script file.
Record a Script creates a script by recording all the actions that you perform in the
HostView window. Actions can include selecting a menu option, typing an entry on the
screen, making selections in a dialog box and so on.
Run Scripts runs specific scripts or individual commands, upon startup or during a
HostView session, to automate specific tasks. You can only run saved scripts.
Activate a recorded Script executes a non-saved script from the current memory.
Save a recorded Script saves your scripts to be used at a later date.
To create a script file:
Select Script | Edit Script. The Edit Script dialog box appears.
Specify the HostView folder in the Look in field in which to store the new script.
Type a name for the new script file in the File name field. You can type any name and
extension that comply with DOS file-naming conventions. It is recommended that you
use a .psl extension, because HostView automatically recognizes it indicating a script
file.
Click Open. A message box displays, asking whether to create a new file.
Click Yes. Notepad opens.
Type the script command(s) that you require.
Select File | Save.
Exit from Notepad.
To edit a script file:
Select Script | Edit Script. The Edit Script dialog box appears.
Double-click the required script file in the files list. Notepad opens and displays the
selected script.
Edit the script as required.
Select File | Save.
Exit from Notepad.
To record a script:
Select Script | Start Script Recording. The menu option changes to Stop Script
Recording.
Perform the manual operations that you want to record. For example, select a menu
option, enter parameters in a dialog box, or type a password.
Select Script | Pause Script Recording if you do not want to record certain operations.
The script recording process pauses and the menu option changes to Continue Script
Recording.
Select Script | Continue Script Recording to resume script recording.
Select Script | Stop Script Recording when you have performed all the operations to be
stored in the script.
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To run a script from startup by creating a Windows shortcut:

This option creates a Windows shortcut to HostView and a specific script file. It can be used to
connect to different hosts using different scripts.
The following procedure describes one way to create a shortcut. Consult your Windows
documentation for a description of other available options.
1
2
3
4
5

6


1
2


Locate the file ptw23.exe on your computer.
Right-click and select Create Shortcut option. The Shortcut to ptw32.exe appears in
the current folder.
Right-click the created shortcut and select Properties option. The Shortcut to ptw32.exe
Properties dialog box appears.
In the Target field, position your cursor after the .exe file name.
Add a space and then type the name of the required script file.
You can also add parameters to the script file. These determine the communication
parameters. For example, it can be the name of the host to which you want to connect, or
the port number.
1. Position your cursor after the PSL script name in the Target field
2. Add a space and type the required parameters. Parameters should be separated by a
space.
Example:
\PTW32\PTW32.EXE COMM.PSL 1 9600 xonxoff
HostView recognizes Windows file naming conventions, including spaces in a file
name. If you have a setup file with a space in the name, HostView ignores the space
and looks directly for the .psl extension.
Click OK. When you start HostView, the script file is automatically executed and you are
connected to the host that you specified in your setup file.
To run a script file:
Select Script | Run Script. The Run Script dialog box appears with a list of all the files
in the HostView directory that carry the .psl extension.
Double-click the script file that you want to run. The selected script file is executed.
To run a script file during a HostView session using Function
buttons:

•

Click the Soft button that has the desired script assigned. The script is sent to the host. For
more information, see “Programming Function buttons”.



To run a script file during a HostView session using the Power
Pad:

•

1

Click the Power Pad button that has the desired script assigned. The script is sent to the host.
For more information, see “Programming the Power Pad”.
To run a script file upon connecting to a host:
Select Communication | Connect. The Connect dialog box appears.

60
2


1
2
3

•

1
2
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Type the desired script file in the Script File field or browse for it. For more information,
see Step 6: “Connecting to a Host”.
To run individual script commands:
Select Script | Script Command. The Script Command dialog box appears.
Type the name of the script command you want to run.
Click OK. The specified script command is executed.
To activate a recorded script:
Select Script | Activate Recorded Script. The script currently recorded in memory is
activated.
To save a recorded script:
Select Script | Save Recorded Script. The Record Script dialog box appears.
Select the directory in which you want to save the file.
Enter a file name. The .psl file extension is automatically added.
Click Save. The file is saved with the specific file name.
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Chapter
Menu Reference

5

This chapter describes each of the HostView Menu bar options. Use it for reference only. For a
detailed explanation of each step involved, see Chapter 3: “Using HostView” and Chapter 4:
“Scripts”.
The HostView Menus are:
•
•
•
•
•
•
•
•

File Menu
Edit Menu
Terminal Menu
Communication Menu
Sessions Menu
Options Menu
Script Menu
Help Menu
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File Menu
The File menu provides options to create, save and restore a terminal setup file as well as create
an icon for your current HostView settings, open keyboard and Power Pad settings, and save
them. You can also use this menu to set printing parameters, print and to open a new instance of
the HostView window.

Save Terminal Setup
Saves both terminal setup and communication parameters to the current setup file.

Open Keyboard File
Opens the Open Keyboard File dialog box, which enables you to open keyboard-mapping
settings that have previously been saved.

Save Keyboard File
Opens the Save Keyboard File dialog box, which enables you to save keyboard-mapping settings
in a separate file and open them at a later date.

Open Power Pad File
Opens the Open Power Pad File dialog box, which enables you to open Power Pad settings that
have previously been saved.

Save Power Pad File
Opens the Save Power Pad File dialog box, which enables you to save Power Pad settings in a
separate file and open them at a later date.

Print Screen
Prints the contents of the work area, or the selected text.

Print Setup
Opens the Print Setup dialog box, which contains printing parameters. Displayed parameters
change according to the printer you selected.
•
•

The Default Printer parameter enables you to send the output to the default printer selected.
The Specific Printer parameter allows you to select one of the currently installed printers.

For more details about installing a new printer, consult your operating system documentation.
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Print Setup for Additional Printers
Start/Stop Auto Print
Prints all the data displayed in the work area. This option changes to Stop Printing once the
Start Auto Print function is activated.

Close Print Queue
Closes the Windows print queue manually.

Form Feed
Executes a form feed on the printer.

Line Feed
Executes a line feed on the printer.

Exit All Sessions
Exits all sessions at once.

Exit
Enables you to exit HostView. If you have changed the terminal settings, HostView displays a
warning message asking you if you want to update the terminal settings file.
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Edit Menu
The Edit menu provides options to select, clear, and reverse text in the HostView window and
delete the contents of the history buffer. The Edit menu also provides standard windowing
editing commands (copy and paste), in addition to commands that enable you to copy data to a
file and copy data automatically to the Clipboard.

Select Screen
Selects the contents of the entire work area.

Clear Screen
Captures the entire HostView screen and passes the data to the history buffer. An example of an
application that issues clear screen commands is VMS Mail.

Reverse Screen
Changes the paragraph alignment. You can type from left to right or right to left, depending on
the language you are using.

Clear History
Deletes the entire contents of the history or scroll back buffer. This command is only available
when the history buffer is in use.

Copy
Copies marked text to the Clipboard when the Automatic Copy option in the Edit menu is not
active.

Paste
Pastes the clipboard into the work area. Right-click sends data stored on the Clipboard, to the
host. This operation is equivalent to actually typing the contents of the Clipboard on the host
screen.

Copy Table
Copy As Bitmap
Copy to File
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Copies selected information to a file. If no text is selected, the entire screen is written to the file.

Automatic Copy
Automatically copies selected information to the Clipboard with no need to select the Copy
option.

Copy Right to Left
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Terminal Menu
The Terminal menu provides options to define and reset connection parameters, set the system to
be online or offline, and freeze or unfreeze the screen. The Terminal menu also enables you to
select the system fonts you want to be displayed in the HostView window, or use the default
HostView fonts.

Setup
Opens the Terminal Setup dialog box in which you can define settings for terminal emulations.
This dialog box contains different property pages that enable you to define all aspects of your
terminal setup. For more information, see Chapter 3, Step 3: “Defining Settings for a Terminal
Emulation (Terminal Settings)”.

PowerTerm Fonts
Displays the default fonts defined in the HostView window. The default HostView fonts are
scaleable so that if the window shrinks, the fonts will shrink in relation to the size of the window.

System Fonts
Displays the system fonts you want to be displayed in the HostView window. System fonts
remain the same size, no matter what the size of the window. When you select your own system
fonts, you can only select fixed size fonts. System fonts enable you to select a different language.

Reset
Resets the VT terminal defaults. This command does not apply to HostView’s exclusive terminal
parameters (such as color).

Online
Sets the system to be online or offline.

Hold Screen
Stops communication and freezes the screen. To unfreeze the screen, reselect the command.

Language Selection
Selects each language for the desired HostView interface.
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Communication Menu
The Communication menu provides options to define and modify the communication (session)
parameters, and to connect/disconnect a communication session. The Communication menu also
provides file transfer options. It enables you to set and clear Data Terminal Ready (DTR) and
Ready to Send (RTS) signals as well as select a modem from a list of existing modems.

Connect
Displays the Connect dialog box, which enables you to define session parameters and connect to
a host.

Disconnect
Disconnects the communication session.

Reset Communication
Resets the communication port for COM type communication.

File Transfer Setup
Displays the File Transfer Setup dialog box, which enables you to define host and PC data types
for file transfer.

Receive File
Receives a file from the host via Kermit, Zmodem, Ymodem, Xmodem, Ascii or Binary.

Send File
Sends a file to the host via Kermit, Zmodem, Ymodem, Xmodem, Ascii or Binary.

AUX: Modify Connection
Run Secure FTP
Launches the HostView FTP Client capable of transferring files from one computer to another.

Data File Transfer
Run PrintView
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Send Message

69

Sessions Menu
Overlap
Cascade
Tile Horizontally
Tile Vertically
A list of current HostView sessions
You can toggle between the sessions by clicking the one you desire.
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Options Menu
The Options menu enables you to display and edit the keyboard mapping and define the Power
Pad display. The Options menu also enables you to store a session in a log file and provides
options to show or hide HostView window components.

Change Password
Keyboard Map
Displays the Keyboard Mapping dialog box, which enables you to map your PC keys to host
keys on the terminal keyboard.

Power Pad Setup
Displays the Power Pad Setup dialog box, which enables you to adjust the number of buttons in
the Power Pad. For more information, see Chapter 3: “Using HostView/Programming the Power
Pad”.

Start/Stop Trace
Stores the session in a log file. Raw data is stored in the Capture.log file, while formatted data
with readable escape sequences is stored in the Trace.log file. This menu option changes to Stop
Trace once the Start Trace option has been activated.

Input Trace
Enables you to view the contents of the Capture.log file on the HostView desktop work area.

Hide Menu
Hides the Menu bar. To restore it, select Restore Menu from the Control Menu box.

Hide Tool Bar
Hides the Toolbar. This option changes to Show Tool Bar when the Toolbar is hidden.

Hide Buttons
Hides the Function buttons. This option changes to Show Buttons when the Function buttons
are hidden.

Hide Status bar
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Hides the Status bar. This option changes to Show Status Bar when the Status bar is hidden.

Show Power Pad
Displays the floating Power Pad. This option changes to Hide Power Pad when the Power Pad
is floating.
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Script Menu
The Script menu provides options to record, edit, and run a script.

Run Script
Displays the Run Script dialog box, which enables you to select and run a script.

Edit Script
Displays the Edit Scrip dialog box, which enables you to create a new script or edit an existing
one.

Script Command
Displays the Script Command dialog box, which enables you to run individual script commands.

Start/Stop Script Recording
Writes a script automatically. After requesting Start Script Recording, the manual operations
you perform in the emulation screen are recorded to a script file, until you choose the Stop Script
Recording option.

Pause Script Recording
Pauses script recording. This enables you to exclude certain operations from recording.

Activate Recorded Script
Activates the script currently recorded in memory. The script is saved in memory while
HostView is active.

Save Recorded Script
Enables you to save a script from memory to a specific file to be used at a later date.
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Help Menu
The Help menu provides options for accessing the HostView online help, Getting Started online
help and product information.

Request Tech-Support’s Assistance
Request Administrator’s Assistance
Contents
Accesses the table of contents for the HostView online help.

PowerTerm Scripting Language
Accesses the PowerTerm Script Language Programmer's Reference.

About PowerTerm WebConnect - HostView
Client
Displays product and contact information.

